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Logging In 

 
Start PedCath as you would any Windows program: Click the Start menu, and select PedCath from its own 
program group. 
 
Locating the Data Folder 
If this is the first time PedCath has been run on this computer, a message box 
will appear, telling you that PedCath could not locate the Data Folder.   Click 
OK and the Locate Data Folder screen will appear.  Browse to locate your 
PedCath data files.   
 
When you have located the proper directory, the red light above “Files Found” 
will turn from red to green.  When the light is green, you are ready to proceed. 
Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Locate Data Folder Screen - Red Light   Locate Data Folder Screen - Green Light                    
 
 
Your Password 
After you have located the data files, the PedCath login Screen will appear.   
Enter the user login and the password given to you by your network 
administrator.   
 
The default password for new users is Taussig1!  Once you have used the 
password to login, you must change it immediately, and will be prompted to do 
so by PedCath. 
  
 
Dr. Helen Brooke Taussig, often called the "mother of pediatric cardiology," was born in 1898. 
Dr. Taussig attended the medical school of Johns Hopkins University, where she became interested 
in cardiology. In 1930, she assumed leadership of the cardiology clinic at Johns Hopkins, where she 
encountered many "blue babies." She investigated the reasons for cyanosis and discovered that its 
major cause in cases of Tetralogy of Fallot was insufficient blood flow to the lungs.  
 
Dr. Taussig was a pioneer in devising surgical treatments for congenital heart disease. In 1944, the 
Blalock-Taussig Shunt operation, which she developed with surgeon Dr. Alfred Blalock, was first 
performed. The publication of this procedure revolutionized the medical approach to congenital 
heart disease. It also inaugurated the new specialty of pediatric cardiology and led to he saving of 
many thousands of lives in the decades to come.  
 
In later years, her failing hearing made Dr. Taussig rely increasingly on her sense of touch, using her hands to diagnose 
cases of congenital heart disease. Helen B. Taussig's contribution to pediatric cardiology was recognized through the 
bestowal of many honors, including the United States' Medal of Freedom, the French Chevalier Legion de la Legion 
d'Honneur, and the Italian Feltrinelli Prize. She died in 1986.       

Photo  Karsh, used 
with permission. 
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! After you log in, PedCath opens to the browse screen, with snapshot views of every cath. 
 
 

The Browse Screen 
 
The patient list is located at the upper 
left part of the main screen.  Each 
line shows a patient’s first and last 
names, and the hospital history 
number (MRN).  The cath list, in the 
upper middle, shows cath records 
that have been saved for the selected 
patient.  Each patient may have 
multiple cath records, which are 
identified in the list by date and the 
hospital’s cath number.  To the right 
side of the screen is the staff list, 
which shows the personnel involved 
in each cath, as well as their roles.   
 
The lower two thirds of the screen is 
devoted to a summary of the cath highlighted in blue in the cath list.  On the left there are patient diagrams.  In 
the middle are calculations derived from up to eight hemodynamic measurement sets.  On the right are any 
diagnoses or procedures that accompany the present cath, along with their codes.  Across the bottom are staff 
comments about the cath. 
 
To view a patient’s caths, either click on the patient’s name, or use the arrow keys and the “Page Up” and “Page 
Down” keys to locate the desired patient’s record. 

! To view a larger version of the diagram, double click on it. 
 
Sorting patients 
When you start, you will notice a blue frame around the patient list.  This indicates that the patient list is active.  
If you click on a cath record or staff record, the corresponding list will be highlighted. 
 
Records may be sorted in ascending or descending order by clicking on the appropriate column heading.  For 
example, to arrange patients by medical record number, click MRN in the gray box at the top of the patient list.  
A small arrow will appear next to MRN.  To reverse the order, click in the same place again.  Clicking on any 
of the gray field headings - Name, MRN, Cath Date, Cath No., Staff Name, or Role - will also provide quick 
sorting by field. 
 
 

Locating Patients 
When the patient list is sorted alphabetically, you may quickly jump to records with a specific 
beginning letter.  For example, if the patient list is sorted by name, typing S will highlight the first 
patient whose last name begins with an “S.”  Likewise, if the list is sorted by medical record 

number, typing 4 will highlight the first patient with a medical record number beginning with “4”. For more 
detailed searches, there is a find function to locate a patient.  To access this function, press Ctrl+F [hold down 
the Ctrl key, press F, then release both], click on the binoculars on the toolbar at the top of the screen, click on 
the Find button below the patient box, or select “Find…” from the tools menu.  The find button will highlight 
the first patient it finds matching the search string you enter. 
 
Choosing View > Patient Filter Search from the main menu will allow you to filter the patients shown in the 
grid by the name, MRN, or internal patient ID. 
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Different views in the browse screen 
In the default view, cath records are sorted by patient.  There are other views available and the view may be 
changed by using the View menu at the top of the main window. The following views are available: 

• View by Patient – Shows the list of all patients within the patient grid. 
• View by Cath – Shows the list of all cath reports within the cath grid.  
• View by Staff – Shows your personnel list within the staff grid. When highlighting a staff member, all 

cath reports where they were listed in the case staff will be loaded into the cath grid. 
• Patient Filter Search – Will allow you to filter the patients shown in the patient grid by name, MRN, and 

internal patient ID.  The patients will be filtered as you type within one of the search boxes. The 
patient name filter will include results from partial patient names. For instance typing in “Wil” could 
return patients with the last name “Wilson” and “Wilkins”, while typing “Smith, J” could return 
“Smith, John” and “Smith, Jane”. The patient grid will be empty initially. 

• View by Recent Cath – Similar to View by Cath but will show only the most recent 30 cases within the 
cath grid. When scrolling to the end additional cases are loaded. This can improve load times when 
your cath database becomes large. 

 
You can set your default view for PedCath to load upon startup, in the options on the User tab.  Setting this to 
Patient Filter Search or By Recent Cath will speed up load times. 

! You will need to be in View by Patient or Patient Filter Search mode in order to add new patients, add 
cath reports, or import data from a hemodynamics system. 
 
 
 
 
The Browse Screen Toolbar 
The toolbar is located at the top of the screen, just below 
the menus (File, Edit, View, Tools, and Help). 

! If you forget what a button does, you can find out by 
leaving the mouse over the button for a few seconds.  A 
label will appear with the name of the button. 
 
Editing patient demographics 

Clicking the Edit Patient button or the Edit 
Patient icon will pop-up the Patient Record 
Window.  
 

In this window, you may edit the patient name, MRN, 
date of birth, gender, and race.  Any data with a bold 
label is a required field.  Any data you enter in this 
window will be automatically saved after you click 
OK.  
 
If a diagram template has been created, it is shown here 
as well. From this screen you can print, copy it to the 
clipboard, and save to an image file. Patient 
demographics can be included on the printout. Templates can be added to the patient record from the Browse 
screen Edit menu, or after editing a diagram for a cath report (See section on Diagram Manager). 

! Patient demographics may be edited by double clicking on the patient’s name.   

Personnel 

Edit Patient Record 
New Patient Record 

Edit Cath Report 
New Cath Report 

Import Data 
Find 

Report Setup 
Print Preview 

Help 
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Adding new patients 

Clicking the Add Patient button or the Add Patient icon will pop-up an empty Patient Record 
Window. 
 
 

Editing staff records 
Clicking the View Personnel icon will pop up the staff 
list. Select a staff member and click View/Edit to make 
changes. 
 

 

! New staff may be added by those with administrator level 
access, under; Tools-Options-Administrator-Personnel. You 
can also edit staff from the Browse screen by choosing View-
Personnel. 
 
 
Editing cath data 

To edit an existing cath report; 1) click on the Edit 
Cath Report icon, 2) double click on the cath date in 
the cath list or 3) click the Edit Cath button below the 
cath list. 

 
 
Adding a new cath  

To create a new cath report; 1) click on the New Cath Report icon, or 2) click the New Cath button 
below the cath list. 
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The Edit Cath Screen 
 

 
 
Demographic information 
In the previous section we used a pop-up window to add and edit patient information. These same fields may 
also be edited in the top two lines of the Edit Screen. 
 
Case information 
The case information frame includes cath date, cath number, and procedure start and end times; access notes, 
height and weight; as well as contrast, radiation dose and fluoroscopy data. The only required field is Cath Date. 
(Cath Number and Account Number may be required depending on your export settings). The Vein/Artery 
access information can be set by clicking the Set Access button.  Multiple arterial and venous access sites are 
supported and include the access site (chosen from an option list), sheath size and closure methods. The closure 
methods can optionally be printed on the report based on per-cath and global settings. Use the override boxes to 
modify the text that will appear on the report if needed. 

 
Adding cath personnel and their roles 

 
Add personnel to this cath by clicking on the Add Personnel to Cath Report icon.  
 
 
Delete personnel from this cath by clicking the corresponding row in the grid and clicking on the 
Remove Selected Person from Cath Report icon. 
 

To change the role of the staff member, either double-click on the role, or click once and then click on the gray 
box on the right hand side of the field.  A drop down list will appear with the roles at your hospital.  

! When adding personnel, users with Full-Edit permissions will be able to add “No-Access” staff to the 
global personnel database here if they don’t already exist, such as Referring Physicians. 
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Hemodynamic Sets 

! You can use the Tab key to move 
logically through the data entry screen. 
Pressing Tab will move to the next field 
while Shift-Tab will move to the 
previous field. Try it! 
 
Although the top half of the edit 
window stays the same for an entire cath report, the bottom half changes with each set of hemodynamic 
measurements.  Up to eight hemodynamic sets can be associated with a single cath.  The name of the set may be 
selected from the drop down box on the left hand side of the screen.  This will contain common conditions that 
your hospital uses to gather hemodynamic data.  You may also manually enter a condition by double-clicking 
this box and typing the name.  Add or delete sets by clicking on the buttons below the set name.  When deleting 
a set, a dialog box will pop up to confirm the deletion. 
 
Calculated values 
 
Calculated values are shown in the lower 
left-hand corner of the edit screen.  
Clicking the “View Calculations” button 
displays a window with all formulas and 
calculations displayed.   
 
Any default value used in these calculations 
can be changed by clicking the Calculation 
Override button and changing the 
appropriate values in the window that 
appears.  
 
Oxygen consumption calculator 
 
You may enter a value for Oxygen Consumption, leave the 
field blank or you may use PedCath’s built in oxygen 
consumption calculations: 
 
Assumed O2 by LaFarge method 
The LaFarge method uses patient gender, age, and heart 
rate to calculate an assumed oxygen consumption.  The 
LaFarge method is only available for patients between the 
age of 3 and 30. 
 
Assumed O2 by Seckeler method 
The Seckeler method uses patient age, weight (kg), 
whether the patient is single ventricle, and if they have a critical illness. The original equation was validated for 
patients 0 through 59 years old. In addition, patients with other conditions, such as pulmonary hypertension, 
could be considered "critically-ill", but these populations were not specifically validated in the original 
manuscript. Use for these patients is based on clinical judgement. 
 
Indexing a measured value: 
If you use a measured value for oxygen consumption (ml/min), the calculator can use the stored value for Body 
Surface Area to compute an indexed value (ml/min/m2).  When you open the calculator, the BSA value will 
automatically appear as the divisor for the oxygen consumption calculation.  Patient height and weight are used 
to calculate BSA. If height and weight data should change, you must re-calculate the value for oxygen 
consumption. 
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Age default: 
If your institution has set up a list of age-based defaults to use, and the patient falls within one of the age ranges, 
the default value will be shown.  Age-based values can be useful for patients under 3 years old, when the 
LaFarge method cannot be used.  
 
 
 

 
 
User Fields 
 
PedCath intentionally limits the number of 
reporting sites in the interest of brevity and 
clarity. Pressures and saturations not listed in 
the site grid can be reported in the comments 
section and/or added to the diagram. 
 
PedCath now offers eight additional sites. The 
site labels can be prefilled with commonly used 
sites (called Institutional Sites in the options). 
Patient specific sites may also be used to record 
sites specific to the current case. If the data is 
filled in for common sites and the report is 
saved, any rows without measurements will be 
removed freeing up space for additional patient 
specific sites.  
 
 

 
 
 
Measurements 
 
A new group of measured values is available in 
PedCath.  
 
Review the default settings under  
Tools>Options>Administrator>Calculations  
to set global values for your institution. 
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Qep  
 
PedCath can calculate, display, and print QEP values.  
In the browser screen, go to Tools>Options>User and  
click on the calculate QEP checkbox to turn QEP calculations  
on or off.   
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PedCath Options 

 
From the Browse Screen, select Tools>Options to open 
the options screen 
 
General Tab 
Allows the user to set guidelines for the destination folder 
for exported files, temporary file storage, diagram 
previews and startup options.  
 
These are per-workstation settings. 
  
User Tab 
Includes options specific to a PedCath user. Options 
include calculation of QEP, whether or not to use smart 
name and/or date formatting, choice of the email address 
book and protocol, and whether or not to use the original 
or Anderson Mullins and Mayer Atlas nomenclature. 
 
The user password may be changed under this tab as well. 
 
 
Global Tab 
Personnel roles may be added, deleted, or their rankings 
changed under this tab.  Which staff roles will be included 
on the cath report and which will be authorized to lock a 
cath may also be determined here. 
 
 
Administrator Tab 
This tab includes global settings accessible to a PedCath administrator. The options available include: 

• Managing the personnel database, configuring staff options, configurating login constraints, and 
enabling Active Directory support. 

• Setting calculation constants and options 
• Setting Institutional sites (up to 8). 
• Configuring import and export options, custom interfaces, and CVIS integration options. 
• Launching the Administrative Console to perform maintenance and other administrative functions. 

(See pg 32). 
• Setting report locking options. 
• Setting the billing codes code set (ICD-9, ICD-10, or ICD-11) and code sync options. 
• Specifying field units (for radiation fields). 
• Setting audit logging settings. 
• Other Misc. options such as auto-incrementing the cath number, auto-logoff, and enabling global style 

sheets for documents. 
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PedCath Imports 

 
Overview 
If your institution is licensed to use the PedCath Direct Data Import interface for your Cath Lab, you will be 
able to import patient demographics, case, and hemodynamic data as well as the procedure log and any 
available angio/snapshot images directly into PedCath from your hemodynamic monitoring system. 
 
The cath report should not exist prior to import; it will be created during the import process. PedCath8 however 
does give you added flexibility to run the import at any time into an existing case to bring in select components 
(see the Import Into an Existing Cath section).  
 
You are always free to create and edit case data manually, whether it is brought in with the Direct Data Import 
Utility or not. 
 
Please note the following sections show the interface with the GE MacLab.  The interfaces have minor 
differences, but largely work in the same way. 
 
 
Running the Direct Data Import Utility 
 

  From the PedCath Browse screen click the Import Data button on the toolbar, or choose Tools > Import 
Cath Data (F4) from the main menu. 
 
 
The Direct Data Import Utility screen will show a list 
of cases that have been sent to the Import folder from 
your hemodynamic system.  
 
Any entries that show up in red have already been 
imported and cannot be imported again.  (the 
administrative Import settings will allow you to 
configure  whether files should be deleted or renamed 
after they are imported so that they will no longer show 
in the list – cleaning up the files will also greatly speed 
up loading the Import Module). 
 
Any entries that show in yellow should be checked to 
see if the patient’s demographics (Name, Birth Date, 
MRN) in the hemosystem exactly match what’s 
currently in PedCath. Double click the entry to see 
what fields do not match. 
 
PedCath8 will allow you  to import more than one case 
per day for a given patient. 
 
 
 
 
To start the import process, highlight a patient’s case in the grid and click View Data. This will bring up the 
Import Review screen. 
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Import Review Screen 
 
The Import Review Screen will show you what will be brought into PedCath during the import. You will have 
the chance to choose the best hemodynamics to bring in for the case, map staff to PedCath staff records, and 
selectively import case data, documents and images. 

! You have control to set any grid cells that have a white background; the cell values will determine what data 
will be brought into PedCath and what fields they will be stored in.   
 

! Any rows with blank white cells will not be brought into PedCath. 
 
 

 
 

Hemodynamics 
The first two columns of the Hemodynamics grid show the field names and data values taken from your 
hemodynamic system. The third column “PedCath” shows what fields the import data will be saved to in the 
PedCath database.  
 
Because PedCath stores summary data and not every measurement taken, you must choose the best 
hemodynamic measurements to bring into PedCath, if more than one measurement was taken for a site per 
condition. By default PedCath will choose the last measurement taken.  
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To choose a different measurement, click the cell within the “PedCath” column and choose the field name 
where the data should be mapped from the drop-down list. Any other measurements taken for that field will be 
cleared for that hemoset. 
 
For example to bring in the first RV pressure rather than the second, choose RV Pressure in the pull down menu 
next to the first RV measurement: 
 

 
 

PedCath will allow you to bring in at most eight hemodynamic sets. If there are more you must choose what 
sets to exclude from the import by highlighting a row within that set and clicking Unmap Set. 
 
There are some measurements that PedCath stores per hemoset that may have been measured at multiple sites 
during a case condition (such as the heart rate or blood gases). Depending on your hemodynamic interface, 
PedCath will allow you to choose the site to take the measurement from, in a pop-up list. If you see a box with a 
“…” next to the measurement when you click the row, clicking the button will bring up the list of site 
measurements to choose from. 
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Staff 
When you first start using the PedCath Direct Data Import Utility, the Initials and Role columns will be blank.  
You will need to associate those columns with the staff name and role in the first two columns, in order for 
PedCath to import the staff members.   
 
To do this, expand the drop down list to find the users login (usually their initials) in the “Initials” column. 
Their default PedCath role will populate the “Role” column automatically. If this is not the correct role for the 
case, choose their role in the drop down list in the “Role” column. 
 
PedCath will remember your choices for future imports.  
 

 
 
 

Document and Image Resources 
The document and image resources group shows what resources will be brought into PedCath. Documents will 
be saved to the Document Manager, and images to the Image Manager. If a resource is unchecked within the 
Import column, it will not be brought into PedCath. 
 
You can view a document or image by highlighting it in the list and clicking the document/image icon on the 
right side of the screen. 
 
You are also free to edit the document or image titles by double-clicking the cell within the “Title/Description” 
column. 
 

 
 

Import 
When you have had a chance to review the import data and all of the mappings look good, click 
the Import button. 
 

A new cath report will be created in PedCath, and will be highlighted on the Browse screen. 
 
If you find particular measurements are not coming over or you would prefer certain measurements to be 
mapped to a different field, contact your PedCath administrator to work with Scientific Software Solutions to 
resolve the mappings. 
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Importing into an Existing Cath 
 
PedCath will allow you to import data into an existing cath report as well.  
 
Importing into an existing case could be useful for a number of scenarios: 
 
         - When you would like to work on the case diagram before the initial import. 
 
         - When importing documents/images that were not available when the case was first imported. 
 
         - Reimporting the hemodynamics, or any other section, and not having to delete the case and start over. 
          
        - Importing data after each condition during the case to review a summary of the 
hemodynamics/calculations in the lab or to auto-embed the measurements in a PedCath Live diagram. 
  
To load data into an existing case, load the Edit Screen for that case and from the main menu choose  
 
 File > Import Into Current Cath 
 
This will load the Direct Data Import Utility, with only matching cases showing, if any. 
 

- Highlight the case and click View Data 
 
 
This will show the Import Review screen, but with check boxes next to each report section.  All sections are 
unchecked by default, except for the cath section (only with fields that are updated throughout the case such as 
fluoroscopy time and contrast, which will more easily allow for progressive imports). It is possible to configure 
the default overwrite options. 
 
-   Check off the sections that you would 
like to bring in (Cath Data, Personnel 
Data, Hemodynamic Data, and individual 
documents and images.) 

 
-  For the Hemodynamic Data section, set 
the Overwrite mode as desired: 

- Fill Empty Fields:  This will 
bring data into fields that are 
blank in the PedCath database, 
and will leave existing data alone. 

- Overwrite All: This will 
overwrite all data whether 
something is there or not. 

 
The number of hemodynamic sets must 
match what is currently in PedCath (or 
otherwise no hemosets should exist in the 
existing PedCath record). 
 
The personnel records can either be merged with the existing records or replace them.  
 
Check off any documents and images you would like to bring in. Any that match existing resources will replace 
existing ones by default. To bring those in as new resources instead click within the cell on the Overwrite 
Options column to set it to Add New from the pull-down menu.  

 
 

Click Import to import the data into PedCath. 
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PedCath Exports 

 
Overview 
PedCath has a wide array of export capabilities to externalize the cath report data once it is completed. You can 
configure PedCath to allow manual exports and/or automatic exports when a cath report is saved or locked in a 
variety of both visual and data-driven formats. 
 
Export Protocols 
Files (Windows Sharing) – You can save the PedCath report data to one of several file formats. When running 
automatic exports you can specify local or shared network locations for the file(s) to be saved to. See the next 
section for supported file formats. 
 
Print – PedCath will allow you to print the report to a printer attached to your local computer or network.  
There are many options to configure what is printed on the report.  
 
FTP – You can send the PedCath report in any file format via the File Transfer Protocol. This can be done both 
manually and automatically when a report is saved or locked.  When configuring the FTP setup, you have the 
option to strip patient identifying data if the files are to be exported outside of your organization.  SFTP is also 
supported (over SSH-2) and is recommended when sending data with patient identifying information to outside 
of your institution.  
 
Email – We support any MAPI-enabled mail client and will load your default mail client with the PedCath PDF 
report as a mail attachment. 
 
Supported File Formats 
HTML (.htm) – PedCath can generate the report as a hypertext document that can be displayed within any web 
browser. 
TEXT (.txt) – PedCath can export the report to a simple ASCII-format text file for simple parsing or backup. 
PDF (.pdf) – PedCath also supports Adobe’s PDF document format. Files of this type have the advantage that 
they cannot be altered and preserve the original page layout when printed or viewed on different platforms. The 
PDF export has many configuration options that can be set during the report setup. This is the format PedCath 
uses for printing. 
 
Optional Formats 
XML/XSL (.xml / .xsl) – PedCath can write the report data in XML format, which is becoming the standard for 
data exchange between systems. We also export an XML stylesheet file (XSL) that presents the XML data in a 
web page format. If our PDF document or our XSL style sheet does not suit your needs for the printed report, 
your organization can develop its own XSL file to define the presentation of the XML data.   
http://www.w3.org/Style/XSL/ 
  
Version 1 of the XML export will include the XSL style template, however versions 2 and above do not because 
they are written primarily for data exchange with EMR systems. The later versions are more inclusive of the 
report data. You can configure which version to use in the export administrative options. 
  
HL7 – PedCath can write the report in the industry standard Health Level 7 format.(v2.3.1). 

http://www.w3.org/Style/XSL/
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Manual and Automatic Export 
PedCath allows you to configure which exports PedCath 
users may export manually and which ones will be 
automatically exported when the cath report is either 
locked or saved. 
 
For manual exports you can also force the user to enter 
their user name and password before they can export. 
 
For automatic exports the default path is set to the export\ 
folder within the PedCath network directory. Each user 
has the choice to use the default path or set it to a different 
location. That is set on the General tab, and can set 
globally there as well.  
  
You can also define the file name format for the automatic 
exports by combining fields such as the MRN and cath 
number. 
 
There are configuration options for several of the file 
types to configure the content and resources that are 
included, header information, etc., within the Advanced 
Export Options. 
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Cath Report Component Managers 

! The six buttons (shown at right) launch (left to right) the 
comments, diagnoses and procedures, adverse events, and the 
diagram, image, and document managers.   

 
 
Comments 

Comments may be edited by selecting the comments 
button on the toolbar, pressing F2, or selecting 
“Comments…” from the view menu.  This is the best 

place for short notes. For longer commentary, entire documents 
may be added to the report. 
 
Diagnoses and Procedures 

 
 The diagnoses coding screen may be activated by selecting the Dx button on the toolbar, pressing 
Ctrl+D, or selecting Diagnosis and Procedures from the 
tools menu. 

 
To add a code, you may either browse through the Code Set box 
or use a search facility. 
 
In the Code Set box, expand the folder list by either double 
clicking on a folder or clicking on the + sign to the left of the 
folder you wish to open.  Select a code by clicking on it.  To see 
the full name of long descriptions, use the scroll bar at the bottom 
or leave the mouse over a description for a few seconds; in the 
latter case, the full name will appear momentarily.  To add a code 
to the cath, use either the Add button or double click on the code.   
 
To add a code via the Search for Code box, enter a code in the small text box on the left.  If this box matches a 
code exactly, the code is displayed in the text box immediately to the right.  Click Add to add this code to the 
cath.  Notice the Copy List button to the right of the Selected Diagnoses and Procedures list.  This will allow 
pasting of the selections under Comments or into another document. 

! You can add a code via the Search by Name box. Just enter a part of the name of the code for which you 
are searching.  For example, entering stra, the selection box will list all diagnoses that contain the letters “stra” 
in order, such as “00105. Stradling mitral valve,” and “00106. Stradling tricuspid valve.”   
 
Select Dx. codes by double clicking or highlighting and pressing the Add button. 
 
You may remove a patient’s Dx. codes by highlighting them, then clicking the Remove button. 

! You can change the position (order of importance) of a selected code by highlighting it and then clicking 
the up and down arrows in the Rank box to the right.   

 
Click the “Set Status Post” button to mark a procedure as status post. Procedures imported from earlier cases 
will automatically be set to status post.  This option is not available for all coding sets. 
 
Adverse Events (Optional) 
Adverse Events is an optional button. If activated, this button will open the Adverse Events screen.  This will 
present the Adverse Events code list and relevant qualifiers. 
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Diagram Manager 
 
 To access the diagram manager, press F6, 
select “Diagram Manager…” from the Report 
menu, or click on the Diagram Manager button 

in the upper right of the edit screen. 
In the Report Diagrams selection box in the upper left 
of this window, you may select the diagram you wish to 
view.  A preview will appear on the right.  Each 
diagram may be associated with between zero and four 
hemodynamic sets.  Click the check boxes of the hemo 
sets which you would like to associate with each 
diagram.  To remove a diagram, click the button 
marked with an “X.”  To add a new diagram, click on 
the Add Diagram button, the button marked with a 
folder on the far left of the toolbar. 
 
Adding Diagrams 
To add a diagram, expand the folder list by either 
double-clicking on a folder or clicking on the + sign to 
the left of the folder you wish to open.  Select a heart 
description by clicking on it; a small preview will 
appear on the right.   
 
For most of the original diagrams there are variations 
available (such as adding an LSVC to the Left Atrium, 
LSVC to the Coronary Sinus, or Right Aortic Arch). To 
choose a variation, select one of the choices within the 
Diagram Modifications group. You can also choose to 
use a wider version of a diagram that shows expanded 
pulmonary arteries, by clicking the Wide version box.   
The Mirror diagram box will flip the diagram 
horizontally for Dextrocardia patients.  
 (Note: If the diagram modifications are greyed out, you 
may be missing the new diagrams. Click the Update 
Atlas/Supplement button to install the latest diagrams 
from the web or from a PedCath CD). 
  
Once you have chosen the diagram that best matches 
the patient, click the Select Diagram button at the 
bottom of the form, and the diagram will be added to 
the cath. 
 
On the Other Diagrams tab you can create an additional 
atlas of diagrams for your institution. You can add 
diagrams to the User Atlas from a file or from the 
current patient’s template.  
 

To add the patient’s template to the 
User Atlas, click the Load Template 
button and then the Add Template to 

Atlas button. To load the template directly to the cath 
report, click the Load Template button and then the Select Diagram button.  Adding the template to the cath 
report can also be done directly from the Diagram Manager screen. 
 
We provide an atlas of supplemental diagrams preloaded into the user atlas, that includes surgical and device 
implantation diagrams. (You can see if your supplement is up to date by running the Update Atlas/Supplement 
module). 
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Editing Diagrams 
To edit a diagram, click on the pencil icon in the toolbar in 
the diagram manager or double click on the diagram you want 
to edit.  This will activate the drawing screen. 
 
The PedCath drawing program is specially designed to help 
you produce anatomical diagrams for your cath reports.  The 
drawing tools are easy to use, and should look familiar to 
anyone who has used other Windows drawing programs.  
Hemodynamic data appears in a table next to the picture, 
allowing you to drag numeric values directly to the diagram. 

! If you make extensive changes to the patient diagram, 
you may wish to save the diagram as a template by clicking 
the Save Template button. This option will save this diagram for this patient, allowing it to be recalled in the 
future. Each patient may have only one template. 
 
 

Embedding Hemodynamic Values in the Diagram 
You may automatically embed all hemodynamic values from the data grid to the diagram.  Values 

embedded in this way will appear at the appropriate places in the anatomy image, and will use the same 
automatic formatting features as when the same values are manually inserted.  The Undo feature does not apply 
to embedded data; however, you may cancel an embed operation by closing the edit diagram screen without 
saving. 
 
 
Edit Diagram Toolbar 
The Edit Diagram toolbar contains options for adding 
various elements to a patient’s diagram: 
hemodynamic data and other text, as well as arrows, 
lines and shapes. Each element that you add to the 
diagram is called an object. Use one of the six 
drawing tools to add or edit objects on the diagram.  
Each of the tools has specific options, which are 
displayed below the toolbar.   
 

Undo Create Object 
Click this icon to undo the last drawing 
operation. 

 
Flush 
After you have added drawn objects to the diagram, they can be moved or edited individually until you 
either save the diagram or press the flush button. Although flushing does not save the diagram to the 

patient’s cath record, flushing the objects in the diagram makes them part of the diagram bitmap; they no longer 
exist as separate, editable elements.  After an object has become part of the drawing, you can modify that object 
only by drawing over it.   
 

Selection Tool 
Use the selection pointer to select objects for editing or deletion.  Only objects added to the diagram in 

the current editing session may be selected.  After you have clicked the selection tool, the mouse pointer will 
change to a bull's eye when it is over a selectable object.  Click in the drawing on any object.  A box will appear 
around it indicating that you may use one of the drawing tools to change it, or drag it to a new position on the 
diagram.  To delete a selected object, press the Delete key.  You may also select an object by right clicking on it 
with the mouse, even if you have not previously chosen the Selection Tool. 
  

Text Tool 
Choosing the text tool shows a text box where you may enter a string of characters to be placed on the 
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diagram.  Select a font and other formatting options, and then click on the diagram where you want the text to 
appear. If you click on any value in the hemodynamics tab, that figure will appear in the text box.  You may 
format it as you would any text, and click on the diagram at the appropriate location.  You may also pre-set the 
formatting options, and drag numbers onto the diagram with the mouse.  Automatic formatting, such as the bar 
over mean values, will override your formatting when you use the drag and drop method. 
 

Eraser Tool 
Erase parts of the diagram with a freehand eraser.  Set the eraser thickness, and then drag the mouse on 
the diagram while holding down the left button. 

   
Freehand Tool  
Draw freehand lines and shapes using the freehand tool.  Set the line color and thickness, and then drag 
the mouse on the diagram while holding down the left button.   

! Drawing with any tool in white works as an eraser.  
 
 

Line Arrow Tool  
Draw straight lines and arrows with the line tool.  To draw a line, click at a starting position on the 
diagram and hold the mouse button down while you drag to the point where you want the line to end.  

Release the button to place the line on the diagram.   Arrows are useful for indicating the catheter course.  
Select a size for the arrow’s head, and draw a line.  You may place the arrowhead at the beginning or the end of 
the line. 

 
Rectangle, Ellipse, and Blob Tools 
 Use one of the three shape tools to draw enclosed shapes on the diagram: (left to right) 

rectangles, ovals, or irregular shapes (blobs).  For each of these shapes, set a Line Color for the outline, and a 
fill color for the enclosed, inside area.  You may also select a fill pattern; for non-solid patterns, the transparent 
option will allow the diagram beneath your shape object to show through. 
 
Tip: The blob tool is useful for drawing in stents by tracing an outline of each stent along the walls of an 
artery. Try using a diagonal crisscross Fill Style, and a transparent Fill Mode. 

 
 

 
 
 
 
 
 

 
 
 
 
 

! If you are working on a complicated diagram we recommend saving often.  You can set up a Save 
Reminder in the Options menu within the Diagram Editor.
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Image Manager 
To activate the Image Manager, click on the camera icon 
in the Report Component Manages window. You can 

also launch the Image Manager by pressing F7 or selecting “Image 
Manager…” from the Report menu. 
 
The image manager allows you to add images and captions to the 
cath record. To add an image, click on the folder icon in the image 
manager.  A window will pop up allowing you to find and select an 
image to attach.  A caption may be entered in the text box along the 
bottom of the image.  To remove an image, click on the button with 
an “X,” just to the right of the Add Image button.  When multiple 
images are associated with a cath, previews of the images are 
displayed along the left and right margins of the image manager 
window.  To view an image in a larger size, click once on it, and 
the yellow cursor will surround the preview of the image. 
 
 

To swap two images, click on one of the two images you would like to switch.  Click on the third button 
from the left, and, following the on-screen instructions, click on the second image you would like to 
swap. 

 
 
You can copy the currently selected image to the Windows clipboard, or paste an image from the 
clipboard into the Image Manager.  

 
 
Click this button to add a duplicate copy of the selected image to the Image Manager. 
 

  
These options will allow you to shrink the resolution or change the format of images currently in 
the database, or set up to have image modifications applied automatically during imports. This can 

be helpful to conserve disk space. 
 

 
To edit an image select it within the Image Manager 
Window and click the Edit Image button. The Image 

Editor (shown right) allows you to draw lines, shapes and text 
similar to how it is done in the in the Diagram Editor (see 
previous section for more details). 
 

A crop tool is also available to zoom into a 
particular area of the image for greater detail. To 
crop an image click the crop button and draw a 
rectangle over the part of the image you would like 
to keep on the pop-up dialog. Once an image is 
cropped it cannot be reverted to the original so it’s 
recommended to make a copy of the original image 
within the Image Manager to work from if you plan 
to crop it. 

 
 
 
 
 
 
 
 
PedCath will allow you to select which images appear on the cath report on the Report Setup dialog (see the 
Report Setup section, page 26). The report image selections will be retained for each cath report.  
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Document Manager 
To show the document manager, press F8, 
select “Document Manager…” from the 

support menu, or click the Document Manager 
button from the upper right corner of the edit 
window. 
 
The Document Manager enables you to import 
existing documents into the report or create new 
ones.  You may also open, modify, and delete 
documents using the Document Manager.   
 
When you click Import File, you may browse and 
select the document you wish to import.  You may 
import documents in the following formats: *.rtf, 
*.txt, *.doc, *.htm, and *.html.  PDF files are also 
supported for import, but as read-only documents. 
 
Clicking Create New Document will open the Document Editor (below), which allows you to create documents 
containing tables and images.  
 
There is a preview of the document that is currently selected in the lower left window. You can edit an existing 
document by clicking this window or by clicking the Edit File button. 
 
The Document Manager also allows your institution to keep an archive of Document Templates to pull related 
documents into the cath report. The documents listed within the My Cath Documents tab can be seen only by 
you, and those listed under Network Documents can be seen by all PedCath users. We provide over 20 
documents for the institutional document archive to get you started.  PedCath administrators can modify the 
hospital-wide archive. 
  

 
 

The document editor is also linked to the cath report resources and will allow you to easily insert them within 
the document, including cath diagrams, images and other documents from the My Cath or Network Documents 
templates. Those can be added from the Insert menu.
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Edit Cath Report Screen Toolbar 
 
 
The six icons on the toolbar in the upper left of the Cath Report 
Screen (left to right) return to the Browse Screen, save changes, 
launch patient billing information, launch the report set-up, provide 
a print preview, and open help information.   
 
 
 
 
 
 
Billing Information 
 

To access patient billing information, press Ctrl+B, click the Patient Billing Information button on the 
toolbar, or select “Patient Billing Information” from the tools menu. 
To add a code, you may either browse through the All codes box or use a search facility. 

 
In the All codes box, expand the folder list by either double clicking on a folder or clicking on the + sign to the 
left of the folder you wish to open.  Select a code by clicking on it.  To add a code to the cath, use either the add 
button or double click on the code.  If a code is added to the active cath through these methods or the others 
discussed below, it will be displayed as bold in the All codes box. 
 
To add a code via the Search by Code box, 
enter a code in the small text box on the 
left.  If this box matches a code exactly, the 
code is displayed in the text box 
immediately to the right.  Click Add to add 
this code to the cath. 
 
To add a code via the Search by Name box, 
enter a part of the name of the code for 
which you are searching.  Select the code 
that you wish from the results to add and 
press the Add button. 
 
In the “Codes for this Cath” box, you may 
change the number field by clicking the up 
and down arrows in the Count box to the 
right.  You may also remove codes by 
clicking the remove button. 
 
To add the -22 modifier to a billing item, select it and click the “-22” toggle button. 
 
To add the -63 modifier to a billing item indicating a patient less than 4 kg, select it and click the “-63” toggle 
button. 
 
Procedural (CPT) and Diagnosis (ICD-9, ICD-10, or ICD-11) codes are included in the All codes listing. 
Administrative options are available to specify which sets are available. If multiple sets are available the set 
being used is displayed above the All codes list, and can be changed using the pull-down combo box. 
 
Once the codes are added, PedCath will allow you to print a billing sheet or email it as a PDF file (“Send” 
button). 
 
 

Return to 
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Locking the Cath Report 

 
PedCath has the ability to lock the cath report so that no edits can be made. To lock the cath report, 
click the padlock toolbar button or choose “Lock Cath Report” from the File menu (shortcut Ctrl+L). 

In order to lock a cath you must be a staff member listed on the cath report with a role with lock privileges 
(Attending’s only by default). Administrators can set the roles able to lock a cath report by choosing “Tools” > 
“Options…” from the Browse screen and clicking the Global tab.  
 
The staff member who locks the report is essentially saying the report is complete and thus signs off on it. The 
report printout will specify that this staff member signed the report. 
 
Administrators can decide whether PedCath users can print preliminary reports and if so the text that will be 
printed on it to indicate that it is unsigned.  To configure this option “Tools” > “Options…” > “Administrator” 
and click the “Report Locking” link. 
 
Auto-export can be configured to trigger either when the cath is saved or when it is locked (default). 
 
 
Unlocking and Creating Updated Reports 
 
To make any modifications after a report has been locked, staff members who have rights to lock a report also 
have the ability to unlock them or to create an updated report. To unlock the report choose “File” > “Unlock 
Cath Report” from the menu.  After 24 hours this menu item will not be available, and you will need to create 
an updated report to make changes. Creating an updated report will make a full backup of the original data and 
resources, before allowing you to make any changes. To create an updated report choose “File” > “Create 
Updated Report” from the menu. 
 
If PedCath has been configured to automatically send reports to the EMR, it's recommended to always use the 
"Create Update Report" command rather than "Unlock Cath Report" to make changes even if you are within the 
grace period. For this scenario the "Unlock Cath Report" command should only be used to fix issues with and 
resend a final report that was initially rejected by the EMR. 
 
You can make as many updated reports as necessary and older updated reports or the original report can be 
viewed from the “View Backup Cath Report” item on the “File” menu.  If you print an older report there will be 
a message on the printout saying that a newer report is available. 
 
If the report you are editing or viewing is an updated report, a message will be shown in the status bar and a 
message will be printed on the report saying so. 
 
HL7 Acknowledgements 
 
If your institution is sending reports to the EMR through HL7 and has HL7 acknowledgement processing turned 
on, PedCath can automatically unlock reports if there are negative acknowledgements received that indicate a 
filing issue. If this happens, the staff member who locked the case will be notified of the issue and that the case 
has been unlocked. This automatic unlocking will ignore the standard grace period but will rather use a timeout 
period if it’s configured.  
 
Server Time 
 
There is an administrative setting to query the server time when locking and unlocking cath reports rather than 
using the local system time. While there are some checks in place to prevent local date tampering normally, 
querying the server time should always prevent date tampering while also making the timestamps more accurate 
and consistent (it’s also possible that a user is working remotely in a different time zone in which case the 
server time would be preferable). This option can be set in the Report Locking section of the Administrative 
Options. Any Windows system can be used for the time server; it doesn’t have to be the same as the PedCath 
data share. 
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Lock Reminder 
 
There is a per-user setting that will show a lock reminder after changes have been made to a cath report and 
saved.  At least 1 diagram must exist and 1 set of hemodynamics before the reminder is shown. The setting can 
be turned on in the Options on the User tab. 
 
 
Report Setup 

 
 To setup, preview, and print a cath report, press Ctrl+R, click 
the Report Setup button on the toolbar, or select “Report 

Setup…” from the Report menu. Reports can also be printed from the 
Browse screen in the same manner. 
 
On the Components tab select the items you wish to include in the 
report.  A check box is grayed if the associated cath component is not 
available for the current cath report.  For instance, if there are no 
images, the Images check box is grayed; if you do not check the 
Documents check box in the Components box, each individual 
document’s check box will be grayed in the Documents box. 
 
In the Images box, you may select the layout of the images.  Clicking 
the Select Images button will allow you to choose which images to 
include in the report, and optionally retain those choices for future 
printouts. 
 
On the Options tab you can select many report setup options  
such as the page number location, the caption to be used for diagrams, 
if any, as well as the ability to hide null calculations or blank grids, or 
replace the calculation block with the hemoset grids (if more than one 
hemoset is shown on the page). The CRISP score can also be included 
on the report if calculated. 
 
By clicking the “Diagram/Hemoset Options…” button you can specify 
which diagrams are to be printed and if summaries of all associated 
hemosets will be printed on each summary page or just one expanded 
set. 
 
The “Dx/Comments/User Sites Options…” will give you control over 
inclusion and positioning of the diagnoses, diagnoses’ comments, and 
cath comments. You can choose to roll the cath comments to the 
second page for instance, or choose to print the Dx comments rather 
than the Dx procedure list. 
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You may preview your report by clicking the Preview button. 
 
 
When you are satisfied with the appearance and content of your cath report, press the Print 
Button and select the number of copies you wish to print. 
 
 
You may also save the report in one of several formats; including ASCII, HTML, PDF, 
XML, or HL7. The PDF file will look the same as the printed report and uses the options 
set from the report setup. You can also email the PDF report by clicking the ‘Send…’ 
button, or manually send the report via one of the FTP profiles set by your institution. 
 
  

 
 
You may optionally save your report settings so that the next time you go to print a report 
the settings will load the same way. The settings can also be saved globally for all users. 
 

 
Global Report Settings 
 
If you are a PedCath administrator clicking Save Settings will allow you to make the active report settings 
global for all users. This will achieve a consistent layout for cath reports generated across workstations. 
 
To enable global report settings click “Configure Global Settings” and check “Use Global Report Settings”.  To 
allow users to override the global defaults also check “Allow users to save personal report settings”.  
 
To save the currently selected report setup (report components included and other options), select Save Globally 
for All users on the Report Settings Scope dialog and click OK.  
 
 

 

 
The global settings will be used whenever the report is printed as well as for any auto-exports set up. 
 
Users will always be able to alter the report sections included and options for any individual report when 
printing, no matter if global settings are used or not. 
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Data Reports 
 
PedCath includes a data reporting tool that can be used to create reports based on criteria (query items) 
specified for your cath database. For example, a report could display all the caths where the patient was less 
than 7 days old, or list all the patients with Tetralogy of Fallot where Dr. Everett was the attending physician. 
Once the report query is run, the report will be created as a PDF document that can be printed, saved, or 
emailed.  
 
The Data Reports module has been rewritten in version 8.1. New features include a user interface overhaul, 
expanded data fields (including hemodynamics and IMPACT Registry data),  and the ability to load the query 
results into the PedCath Browse screen.  
 

 
Creating a Report Query 

 
On the PedCath main screen (Browse screen), click the Tools menu and choose “Data Reports…”  The “Data 
Reports” dialog will be displayed. Criteria may be entered here to filter for the desired records. 
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Let’s say we want to create a query for all cath records for 
patients less than 3 months old where Dr. Everett is the 
attending physician.  
 
In this case we would need to create two query items – one 
for Dr. Everett being the attending physician and the other 
specifying the age to be less than 3 months.  
 
To do this expand the Staff entry tree group in the Cath Data 
tree by clicking the + next to it and check off “Allen D. 
Everrett, MD”.   
 
The Query Field pop-up will be displayed.  
 
Leave the query type set to “Is Any Of:” and 
check “Attending”   
 
Click Set Query to confirm the query. 
 
 
 
 
 
The query item will be added to the Query 
Summary area at the bottom of the screen.   
 
 
 
 
To add the query based on the Age at Cath, check 
the “Age at Cath” item in the Cath Data grid.  
Choose “Is Less Than” as the query criteria, enter 
“3” in the text box, and select “Months” from the 
units drop-down box.  Click “Set Query”, and the 
query item will be added to the Query Summary. 
 
 
 
 
 
 
 
 
 

You can edit a query item’s criteria, by double-clicking the field name the query trees (and not the check 
box) or by highlighting the item within the Query Summary area and clicking the Pencil icon (or by double-
clicking the query item). 
 

You can delete a query item by unchecking the box next to the field name in the query trees, or by 
highlighting the item in the Query summary and clicking the X button (or the pressing the Delete key).  
 
 
Note: A query can be saved for future use by clicking the Save button, and a previously saved query can be 
loaded by clicking Load and finding the query file (p8q extension). Please note this file contains the query items 
and report setup but does not contain the results of running the report. 
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Running the Report Query 
 
Make sure to specify if you are searching “By Cath” or “By Patient”. If searching by Patient, the results will 
show a list of Patients who have at least one cath that matches the query. 
 
From the “Data Reports” dialog, click the big “Run” button to run the report query. Processing times can vary 
depending on the size of the cath database, complexity of the query, and speed of the network. 
 
If we run the query entered in the previous sections on the sample data set, 2 cath records are returned as shown 
in the figure below. 
 

 
 
 

Clicking the Preview or Print button will allow you to view/print the results report. You can 
order results rows by clicking on one of the column headers (click a header multiple times to 
toggle between ascending and descending order). The printed report will be in the same 
order. 
 
 
 

 
Clicking the Save As button will allow you to save the report in .CSV format, which can be 
opened and further processed in Excel or other spreadsheet programs. By default the fields 
shown in the grid will be included in the .CSV file, but you will be given the option to 
include additional patient, cath, and staff fields. Additional processing will be required to 

search the database for the additional data.  
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Clicking the Load in Browse Screen button will open the Browse screen showing only the 
patients returned in the query results. Here you will be able to further inspect any of the cases 
returned by the query, and make any changes to any cath reports if necessary. If you did a 
Search By Cath, then only the patient’s caths that matched the query will be shown in the 

Cath grid. To view all of a patient’s cases whether they matched the query or not, check the “Show All Caths” 
box. 
 
Viewing by cath (View > By Cath) is supported while in query mode, but viewing by staff is not. 
 
 

 
 
 
You can make modifications to the query by clicking the Edit Query button.  
 
Click the X on the right side of the yellow header bar to close the Query Results View and show all of the 
PedCath patients. 
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 Administrative Console 
 
The Administrative Console is a separate application from PedCath that contains many administrative features 
such as viewing login information, viewing access log information (HIPAA logging), running database 
maintenance and modifying the staff database.  
 
You can start the Administrative Console from the start menu or within PedCath. 
 
To start from Windows: 
  Start >> Programs >> PedCath >> Administrative Console 
  You will need to enter your PedCath initials and password to log in. 
 
To start from within PedCath: 
  On the Browse screen choose: 
  Tools >> Options … >> Maintenance >> Run Administrative Console 
  You will be prompted to close PedCath if you plan on running the database maintenance utility. 
 
 
Editing Personnel 
 
The first tab contains the PedCath staff listing 
for your organization. Here you can add, 
remove, and modify staff members. The staff 
listing may be edited within PedCath as well 
(see the installation guide for more information 
on these options). 
 
If a staff member contains duplicate records 
you can merge them here. To do so highlight 
the record that you’d like to be the master 
record, click the Merge Staff button, and 
choose the duplicate entry. Repeat the 
procedure for additional duplicates. The 
potential duplicates list only shows staff with 
the same last name (including disabled 
records). The Manage Staff button will be greyed out if there are no matches. 
 
 
Viewing HIPAA Logs 
On the second tab you can view HIPAA 
logging information such as when patients’ 
records were browsed or edited and by whom. 
Many other actions are logged such as 
logins/logouts, exports, cath locks/unlocks, 
configuration changes, and data queries (see 
the reference manual for a full listing). 
 
To view the log click the ‘View HIPAA Log’ 
button. 
 
You can enter criteria to filter the results. The 
criteria includes a date range, patient name and 
MRN, the personnel member who performed 
the action, and which actions you’d like to 
view. With the criteria filled out, click the Show Matching Records button to see the log results. Leaving the 
criteria set to the defaults will show all records found. You can sort each column by clicking the column header.  
 
It’s also possible to open the log in a spreadsheet program such as Excel, as it is in CSV format.  
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If you’ve found the log has grown larger than you would like, there is a function in the database maintenance to 
archive old log entries. 
 

 
 
 

Viewing Legacy HIPAA Log 
The HIPAA log format changed in version 
8.6.3. If you were using PedCath prior to this 
version you may have log entries in the older 
format. Those can be viewed by clicking the 
View Legacy HIPAA Log button.  
 
Here you can view HIPAA logging 
information such as when patients’ records 
were browsed or edited and by whom. This 
information can be seen by selecting a 
filtering option and clicking the “View 
HIPAA Log” button. For instance, to see a 
listing of when a particular patient’s cath 
information was viewed or edited click the 
“View by Patient” option and then the View 
HIPAA Log. 
  
The View HIPAA Export feature works similarly except that it displays information related to exports and cath 
report locking. The last filter option “View by Export Action” is applicable to this feature and will allow you to 
search for a particular action type that happened, for instance a listing of all the cath reports printed. 
 
There is also a feature to clear out and back up old entries from the legacy HIPAA tables.  
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Maintenance 
 
The Maintenance table contains many features 
necessary to maintain the PedCath databases. The 
most important of these features is the Database 
Maintenance wizard which is described in the 
next section. 
 
You can also set up database maintenance 
reminders within the Scheduled Maintenance 
grouping. 
 
There are several options beneath the Other 
Maintenance group. These options are likely to be 
used rarely but are necessary in certain 
circumstances. 
 
Disconnect Data Folder – This will remove the pointer to the PedCath database and it will have to be set the 
next time PedCath or the Administrative Console is run. 
 
Clear Version Data – This will clear the version information from the database making it possible to revert to 
an earlier version of PedCath. 
 
Standard DBF Export  – This will export a snapshot of the PedCath database to a folder in standard DBase 
format. 
 
Prompt for Code Set Sync – This will cause PedCath to check for code set (Diagnosis/Procedure set and 
Billing) differences between the “master” set on the network and the sets that are used on the current 
workstation the next time PedCath is run. 
 
Set DB Lock – This will prevent users from accessing PedCath. This can be used if you are working with the 
PedCath support team to resolve an issue for instance. 
 
Change Dx Code Sets – This will allow you to change from one diagnostic code set to another, while retaining 
your old codes. You will only be able to switch codes once while retaining the legacy codes. 
 
Configure Network Redirector – This will allow you to set a database redirector to be used during database 
migration. All PedCath users who attempt to connect to the current path will be redirected to the new path you 
specify. 
 
Batch Cath Lock – If your physicians start to use the cath locking feature, you can batch lock the legacy cases 
with this command. It’s recommended that each attending physician run this command to lock their own cases, 
and then have an administrator lock the rest.  
 
Rerun Last DB Upgrade – This will set the database version number to the prior version which will force the 
database upgrade wizard to run the next time PedCath is started. This can be helpful if the database upgrade 
needs to be run again or if you are reverting to an earlier version through a minor release (not recommended).  
 
DB Backup – This will allow you to do full or incremental backups of the PedCath database, case resources 
(diagrams, images, documents), and import files to a folder. You can also manually do a backup of the PedCath 
files by copying the entire network folder to a backup location. 
 
Configure Comments Location –Your cath report comments and Dx comments are traditionally stored within 
the database memo file (cathdb.smt). If you have a large number of cases, moving comments to external files 
can improve performance when loading PedCath and reduce the probability of corruption of the comments. 
 
Batch Patient Merge – This will merge duplicate patient records. If two records have the same MRNs with the 
only difference being the leading 0s they will be merged. 
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Disable LDAP – This will disable LDAP auto logins and revert to using PedCath credentials. This can be 
useful if you are locked out of PedCath due to the LDAP server credentials changing or the server being down, 
and you do not have the fallback Login enabled.  
 
Patient Archival/Retrieval – This allows you to back up patients who you do not expect to have additional 
cath procedures for to an external database, which will reduce the size of the database and improve 
performance. Patients who have been archived will not be shown to PedCath users. This form will allow you to 
view patients in the PedCath database and flag them for archival. Batch operations are available such as 
flagging all patients for archival who haven’t had a cath procedure in a specified number of years, or flagging 
patients using an MRN list. PedCath users can also flag individual patients for archival from the PedCath 
Browse screen Edit menu. 
 
You can also view all of the patients who have been archived, and flag them for retrieval. You will need to run 
database maintenance with the appropriate options set to complete the archival/retrieval process.  By default the 
archived database records and files are saved to a sub folder “Archive” of the data folder, but you can move it to 
another location if desired.  
 

 
 
 
Database Maintenance 
 
The Database Maintenance utility can be used to 
perform cleanup and integrity checks on your PedCath 
database. The picture to the right shows the maintenance 
options available. It is recommended to at least run 
indexing options which will rebuild the indexes in case 
they have become corrupted.  The Integrity Check is 
recommended as well and will verify that the ID table is 
valid. The Check Field Data option will check for 
invalid field data. Invalid field data can occasionally 
come from out of range values from your hemodyanmics 
system, and may prevent reports from fully loading. 
Although unlikely, if you encounter an integrity error 
contact Scientific Software.  
 
When records are deleted from a dbf table, the records 
are not actually removed but are rather flagged for 
deletion. Under the Cleanup group checking the 
“Remove Deleted Records” option will actually remove all of these entries from these tables which will shrink 
the table sizes and improve performance.  
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Checking for orphaned records will tell you if there are any cath records without a corresponding patient or any 
cath sub-table records without a corresponding cath record. You should rarely find many orphaned records. 
However, if you find a large number contact Scientific Software for assistance. 
 
Checking “Remove All Record Locks” will remove all dBase internal record locks from the system as well as 
patient locks. If PedCath locks up when accessing a particular cath or patient record it’s recommended to run 
this. 
 
The files stored within the PedCath import folder (Data_In\) are files from your hemodynamics system, and are 
generally not needed after they have been imported. It’s generally good to clean out old files from that folder 
during maintenance. The files can usually be regenerated from your hemodynamics system if needed. The 
import index file speeds up loading the import list, since files will not have to be parsed again to determine the 
patient name and cath date, but it’s good to clean out the table since the entries aren’t needed after files have 
been imported.  
 
Backing up older HIPAA (user access) logs can also speed up the system by shrinking the active log table. You 
will still be able to access the backed-up records within the HIPAA viewer.   
 
In order to complete the archival / retrieval of patient records that have been flagged (either in the admin 
maintenance tools archival module or by PedCath users on the Browse screen edit menu), you would need to 
check off the options here. When archiving records it’s recommended to also have the Remove Deleted Records 
option checked which will reduce the size of the database. 
 
 

 

Viewing Login Information 
 
The fourth tab allows you to see who’s logged 
into the system and see what patients are 
currently being edited.  
 
If you select a staff member and click “Boot 
User” the user will be prompted to save their 
work and close PedCath. PedCath will 
automatically close after a couple of minutes if 
the workstation is unattended. If the status is 
stuck as shutdown notify for more than a couple 
of minutes it could be that PedCath was closed 
abnormally. If this is the case, click “Remove 
Login Record” to remove the record. Only use 
this option to clean up stuck records – if you 
remove the login record while someone is still connected to the database, their PedCath software will be left 
open. If you plan on running maintenance or another feature that requires exclusive access, then PedCath would 
need to be manually shut down where the login record was prematurely cleared. 
 
To boot off all users at once, click the “Boot All Users” button.  
  
You can also choose “Remove Patient Lock” which will release the lock on a particular patient so that another 
user can edit them.  
 
If you are experiencing issues will logins, you can use the Clear Login Table button.  All users would need to be 
closed out of PedCath in order to run this. 
 
The “View Hosts Listing” command will show you a listing of the workstations that have ever accessed 
PedCath. This can be helpful to determine what machines will need PedCath updates. 
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Upgrade (Institutional-Wide Upgrade) 
 
The Institutional-wide upgrade feature allows you 
to specify a PedCath upgrade file to install on all 
machines. When PedCath is started on each 
workstation the upgrade will automatically be 
applied, if needed. You can specify an update file 
(.p7u,) to use as well as a few options. This option 
requires that users have administrator rights on their 
workstations in order to install the upgrade using 
Windows installer. A legacy p7u can also be used 
that doesn’t require admin rights, however it’s 
recommended to check with Scientific Software to 
see if it’s supported for the version you’re 
upgrading to and from. 
 
Force Upgrade - Will lock out users running an 
earlier version of PedCath until they upgrade, even if that version is compatible. 
 
Allow user to install later revision upgrade -   Will allow a user to install a later revision of PedCath than is 
installed on the network. This will allow only revision updates (i.e. 8.4.x to 8.4.y), so that the database will not 
be modified. 
 
 
 

Import Settings 
 
There are some settings that cannot be set through 
the PedCath user interface. This will allow you to 
set those settings directly using a settings file 
(*.p7s). Scientific Software may send you settings 
files to use in certain circumstances, and you would 
apply them on the Import Settings tab by browsing 
to the file and clicking the Update button. 
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